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The Stream Alignment, illustrated in Figure 5.1, represents the river 
system in the watershed.  It indicates where confluences and bifurcations 
occur and provides a sense of distance and scale. 

 
Figure 5.1  Stream Alignment 

In the Watershed Setup Module, Stream Elements (Figure 5.2), Stream 
Nodes (Figure 5.3), and Stream Junctions (Figure 5.4) are the components 
of a Stream Alignment. 

 

 
Figure 5.2  Stream 
Elements 

 
Figure 5.3  Stream Nodes Figure 5.4  Stream 

Junctions 

   

When you create a Stream Alignment, you draw it as a set of connected, 
multi-segmented lines.  The Stream Alignment must have at least two 
nodes, defining the beginning and end of a stream element.  Figure 5.5 
illustrates the relationship of line segments, stream elements, and the 
Stream Alignment. 
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Figure 5.5  Relationship of Line Segments, Stream Elements, 
and Stream Alignment 

ResSim creates and labels stream stations (or river stations) automatically 
along each stream element.  By default, the station at the downstream end 
of an element is Station 0 (zero), and the stationing increases upstream 
along the element according to the linear distance between nodes on the 
stream element in the watershed coordinate system.  You can override the 
default stationing by editing the station values of the stream nodes at the 
upstream and downstream ends of the stream element, as well as by 
adding additional nodes along the stream element. 

Stream stationing is based on the geographic extents you define when you 
draw a stream element.  If you have set the geographic extents to represent 
feet, either manually or by importing a layer projected in feet, the station 
labels will represent feet. 

After you have drawn a Stream Alignment in the display area, you can 
edit, rename, delete, and move its component stream elements, stream 
nodes, and stream junctions using the Stream Alignment shortcut menus. 

5.1 Creating a New Stream Alignment 
You must be in the Watershed Setup Module to create a Stream 
Alignment in ResSim.  Although it is not necessary, you will find it useful 
to display a background map of the river system as a guideline for creating 
your stream alignment.  If your stream alignment is going to be based on a 
map layer, the map layer should already have been included in the 
watershed by copying the map files into the “maps” directory.  The map 
layer should contain water features, such as stream channels and reservoirs 
or lakes.  Use this map layer as a guide while creating the stream 
alignment.  By doing this, the units of the labels on the stream alignment 
will be the same as the units of the water feature layer (i.e., if your water 
feature layer is projected in state plane coordinates (feet), then the labels 
on the stream alignment will be in feet).  Refer to Chapters 3 and 4 for 
more information about adding and displaying maps. 
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You can either digitize a stream alignment by hand or import a stream 
alignment from an ArcView® shapefile.  The following are the steps for 
digitizing a stream alignment (see Section 5.3 for details on importing a 
stream alignment). 

To create a stream alignment: 

1. You must be in the Watershed Setup Module.  On the 
Module list, select Watershed Setup. 

2. On the map toolbar, press the Stream Alignment Tool . 
3. Determine an upstream location where you want to start a 

stream element (typically, you will begin at the upstream end 
of the mainstem and end at the most downstream location of 
the primary river in your watershed). 

4. Hold down the CTRL key.  Starting at the upstream end, draw 
the stream element by clicking the left mouse button at each 
vertex point as illustrated in Figure 5.6. 

Vertex Point

 
Figure 5.6  Drawing a Stream Element 

5. Continue downstream (while continuing to hold down the 
CTRL key) and before placing the last point of the stream 
element, release the CTRL key, and then click the left mouse 
button at the last downstream location.  This creates the ending 
stream node of the stream element. 

6. The Create New Stream dialog box (Figure 5.7) opens.  You 
can either accept the default name or enter a new name.  Also, 
you can enter a description for the stream element.  Click OK 
to close the Create New Stream dialog box. 
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Figure 5.7  Create New Stream Dialog Box 

7. Repeat steps 4 through 6 to add more stream elements to your 
stream alignment. 

8. To create a confluence or bifurcation, end the stream element 
by clicking directly on an existing stream element.  After 
naming the new stream element, the Connect Stream Reaches 
dialog box (Figure 5.8) will appear.  You need to determine 
whether you want to connect the new stream element to the 
existing stream element.  Click Yes if you want the two stream 
elements connected; otherwise click No.  If you selected No, 
and if there are additional existing streams that are possible 
candidates for connecting your new stream element to, then a 
subsequent Connect Stream Reaches dialog will appear to 
give you the opportunity to connect to the existing stream. 

 
Figure 5.8  Connect Stream Reaches Dialog Box 

 
When multiple stream 
elements are connected (e.g., 
at a confluence), a stream 
junction is automatically 
created and appears as a 
highlighted green circle (a 
“light green halo”) as shown 
in Figure 5.9. 

 
9. Once you have completed the creation of your stream 

alignment, save your work.  From the File menu, select Save 
Watershed and the stream alignment for your watershed will 
be saved. 

 

 
Figure 5.9  Stream Junction 
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5.2 Editing an Existing Stream Alignment 
After drawing a stream alignment in the display area, there are many 
options available for revising your stream alignment.  To edit your stream 
alignment, you must be in the Watershed Setup Module.  The Zoom 
Tool can be used to help magnify the stream network, thus providing more 
detail to make editing the stream alignment easier. 

This section describes the following capabilities for editing your Stream 
Alignment: 

� how to refine and re-shape your stream alignment (by 
moving/adding/deleting vertex points of the stream elements) 

� how to review stream stationing and provide a stream element 
description (by using the stream element editor) 

� how to rename and delete stream elements 

� how to add and edit stream nodes (for defining stream stationing) 

� how to move and edit stream junctions 

� how to reverse the flow direction of a stream element 

� how to disconnect a stream element 

 Since the Stream Alignment may be referenced by other models, 
care should be used when making any changes to it. 

5.2.1 Moving Vertices of a Stream Element 
To move a vertex of an existing Stream Element: 

1. Lock the configuration. 
2. With the Stream 

Alignment Tool  
selected, double-click 
anywhere on the stream 
element.  The stream 
element you select will 
turn red and all the 
vertices of that stream 
element will turn blue. 

3. Click on the vertex you 
want to move, and drag it 
to a new location, as 
illustrated in Figure 5.10. 

Figure 5.10  Moving Stream 
Element Vertices 
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5.2.2 Adding Vertices to a Stream Element 
To add vertex points to an existing stream element: 

1. Lock the configuration. 

2. With the Stream Alignment Tool  selected, double-click 
anywhere on the stream element.  The stream element you 
select will turn red and all the vertices of that stream element 
will turn blue. 

3. Place the pointer on the selected stream element where you 
want to add a vertex point.  Hold down the CTRL key and 
click.  A blue point will appear on the selected stream where 
you have added a vertex point. 

5.2.3 Deleting Vertices from a Stream Element 
To delete vertex points from an existing stream element: 

1. Lock the configuration. 

2. With the Stream Alignment Tool  selected, double-click 
anywhere on the stream element.  The stream element you 
select will turn red and all the vertices of that stream element 
will turn blue. 

3. Hold down the SHIFT+CTRL keys and click on the vertex 
point to be deleted.  The blue vertex point will disappear from 
the stream element, and the stream will straighten between the 
two adjacent vertices. 

5.2.4 Editing a Stream Element 
To edit a Stream Element: 

1. Lock the configuration. 

2. With the Stream Alignment Tool  selected, right-click on 
the stream you want to edit. 

3. From the 
shortcut menu 
(Figure 5.11), 
select Edit 
Stream Element 
to open the 
Stream Editor  
(Figure 5.12). 

Figure 5.11  Stream Alignment Shortcut 
Menu 
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Figure 5.12  Stream Editor 

The Stream Editor displays a summary of the stream name, 
description, stationing, and coordinates for a stream element.  You can 
edit only the description. 

Stream name:  
The Stream Editor displays the name of the Stream Element you have 
selected in the list along with all available Stream Elements in the 
watershed.  Also, left and right arrows (navigator buttons) allow you 
to click through the Stream Elements in the watershed. 

Description:  
To edit the Description of the Stream Element, you can type into the 
text area or click the  button to access the Enter Description 
dialog box (Figure 5.13) 

 
Figure 5.13  Enter Description Dialog Box - Stream Element 

Stationing: 
The Stream Editor provides you with a report of the stream stationing 
and coordinates of the Upstream and Downstream nodes, plus any 
stream nodes in between them.  Use the Stream Node Editor 
(described in Section 5.2.8) to edit the stream stationing of the nodes. 
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5.2.5 Renaming a Stream Element 
To rename a stream element: 

1. Lock  the configuration. 

2. With the Stream Alignment Tool  selected, right-click on 
the stream element and select Rename Stream Element. 

3. Enter a new Name and Description for the stream element in 
the Name Stream dialog box illustrated in Figure 5.14. 

Figure 5.14  Name Stream Dialog Box 

5.2.6 Deleting a Stream Element 
To delete a stream element: 

1. Lock  the configuration. 

2. With the Stream Alignment Tool  selected, right-click on 
the stream element and select Delete Stream Element. 

3. When the confirmation message (shown below in Figure 5.15) 
appears, select either Yes or No. 

Figure 5.15  Confirmation Message when Deleting a Stream Element 

 

 It is important to remember that other models may use the same 
stream alignment, so be sure to confirm with other modelers 
before deleting any stream elements. 
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5.2.7 Inserting a Stream Node 
By default, ResSim generates beginning and ending stream nodes for 
each stream element.  Also, stream nodes are automatically created 
where stream elements connect (stream junctions).  Since stream 
nodes are used for establishing the stream stationing, you may want to 
include additional stream nodes along your stream element for 
locations where you want to define specific stream stationing. 

 It is important to keep in mind when defining the stream 
stations that the locations you specify for stationing are 
common to all models that use stationing in their 
computations. 

To insert a stream node on an existing Stream Alignment: 

1. Lock  the configuration. 

4. Using the Stream Node Tool , hold down the CTRL key 
and right-click on the Stream Alignment in the place where the 
stream node is to be inserted. 

5. When you right-click on the 
stream station node, a shortcut 
menu appears (Figure 5.16). 

6. From the shortcut menu on the 
stream node, you can choose 
Edit Node, which will bring 
up the Stream Node Editor 
illustrated in Figure 5.17. 

5.2.8 Editing a Stream Node 
The Stream Node Editor (Figure 5.17) displays the location 
information for the node. 

1. The Use Default Stationing check 
box is selected by default.  When you 
select this option, the current location 
of the selected node displays in the 
Stream Node Editor. 

2. If you want to specify the exact 
location for the node on the stream 
element, “deselect” the  
Use Default Stationing to make the 
Station box editable. 

3. Enter the location for the station 
directly into the Station box, and then 
click OK. 

Figure 5.16  Stream Node 
Shortcut Menu 

 

Figure 5.17  Stream 
Node Editor 
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5.2.9 Deleting a Stream Node 
Since stream nodes define the stream stationing that may be 
referenced by other models, care should be used when deleting stream 
nodes. 

To delete a stream node from an existing Stream Alignment: 

1. Lock  the configuration. 
2. Find the stream node you wish to delete. 

3. Using the Stream Node Tool , right-click on the stream 
node. 

4. Select Delete Node from the shortcut menu. 
5. A Confirm Delete 

message will 
display (Figure 
5.18) asking you 
whether you really 
want to delete the 
selected stream 
node. 

6. Click Yes and the 
message will close and the stream node will be deleted from 
the stream element. 

5.2.10 Moving a Stream Junction 
When two stream elements intersect (e.g., at a confluence), a Stream 
Junction is automatically created.  A stream junction is multiple 
stream nodes at one location and is represented by a dark green circle 
with a light green halo around the circle.  Although ResSim generates 
default stream junctions when you create the Stream Alignment, you 
can move them as needed. 

To move a Stream Junction along an existing Stream Alignment: 

1. Lock  the configuration. 

2. With the Stream Node Tool  
selected, double-click on the 
stream junction.  The stream 
junction you select will turn dark 
green and will have small squares 
(handles) at each corner (Figure 
5.19). 

3. To move the stream junction, 
click and drag it along the stream 
element to its new position. 

 
Figure 5.18  Confirm Delete of Stream 
Node 

 
Figure 5.19  Moving a 
Stream Junction 



ResSim User’s Manual Chapter 5 – Working with the Stream Alignment
 

5-11 

5.2.11 Editing a Stream Junction 
To edit a Stream Junction: 

1. Lock  the configuration. 
2. Using the Stream Node Tool 

, right-click on the Stream 
Junction to access the shortcut 
menu (Figure 5.20). 

 
3. Select Edit Junction to open the Stream Junction Editor 

(Figure 5.21). 

Figure 5.21  Stream Junction Editor 

The Stream Junction Editor displays the list of stream nodes 
associated with a junction and allows you to edit the stationing of 
each of the nodes by deselecting the “Use Default Stationing” box and 
entering the desired station. 

5.2.12 Reversing the Direction of a Stream 
If you find that you have inadvertently drawn your stream element in 
the wrong direction (e.g., downstream to upstream when it should be 
upstream to downstream), then instead of having to delete the stream 
element and redraw it, you can choose to reverse the direction of the 
stream element. 

To reverse the direction of a stream element: 

1. Lock  the configuration. 

2. With the Stream Alignment Tool  selected, right-click on 
the stream element and select Reverse Direction from the 
shortcut menu. 

Figure 5.20  Stream Junction 
Shortcut Menu 
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3. A warning message (Figure 5.22) will open asking you whether 
you really want to reverse the direction of the stream element. 

Figure 5.22  Confirm Reverse Direction of Stream Element 

4. Click Yes and the warning message will close and the stream 
element’s direction will be reversed. 

5.2.13 Disconnecting a Stream Element 
A stream element can be connected to another stream element (e.g., at 
the confluence of two streams).  If, for some reason, you need to 
disconnect the stream element from another stream element, you can 
do so. 

To disconnect a stream element from another stream element: 

1. Lock  the configuration. 

2. With the Stream Alignment Tool  selected, right-click on 
the stream element you want to disconnect and select either 
Disconnect Upstream or Disconnect Downstream, as 
appropriate, from the shortcut menu. 

3. The stream element will now be disconnected from the other 
stream element.  On the display area, the upstream (or 
downstream) point will physically move away from the 
connecting stream element and a stream node will remain 
where the stream element was originally connected. 

5.3 Importing a Stream Alignment 
To import a stream alignment you must first have as an active map layer 
(see “Adding a New Map Layer” in Chapter 3, Section 3.4.2) an 
ArcView® shapefile which represents the stream system of your 
watershed.  This shapefile must have an attribute that is the name of each 
stream, and each stream must form a contiguous line with one upstream 
point and one downstream point. 

To import a stream alignment: 
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1. You must be in the Watershed Setup Module.  From the 
Module list, select Watershed Setup. 

2. Add the map layer that will be imported to the display area (see 
“Adding a New Map Layer” in Chapter 3, Section 3.4.2 to add 
a map layer). 

3. From the Watershed menu, point to Import, and then select 
Stream Alignment. 

4. The Import Stream Alignment dialog box (Figure 5.23) will 
open. 

5. In the Shapefile Name box is displayed one of the ArcView® 
shapefiles defined as active map layers in your watershed.  
ResSim automatically selects the first shapefile that contains 
polylines.  Therefore, if this is not the desired shapefile, then 
from the File menu, select Choose Shapefile. 

6. The Choose Shapefile 
dialog box (Figure 5.24) 
will open.  In the 
Available box, is a list of 
the available polyline 
shapefiles that you have 
added as map layers.  In 
the Selected box, is the 
polyline shapefile that has 
been chosen.  To choose a 
different polyline 
shapefile, use the Add 
and Remove buttons to 
get the correct shapefile.  In Figure 5.24, the polyline shapefile 
to be used for importing the stream alignment is stream.shp. 

Figure 5.23  Import Stream Alignment Dialog Box 

Figure 5.24  Choose Shapefile 
Dialog Box 
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7. Once the correct shapefile has been chosen, the required 
attribute is the name of each stream.  The program 
automatically searches for a database field name of 
Stream_ID.  If there is not a database field name of 
Stream_ID, then in the Database Field Name list, you must 
select the database field name that contains the names of each 
stream.  In the example shown in Figure 5.23, for the shapefile 
stream.shp, the database field name is Stream_ID. 

8. When you have selected the correct database field name, the 
table will list the stream names.  If each stream is a contiguous 
line with one upstream point and one downstream point, then 
the checkbox in the Import column of the table will be set.  If 
there is something wrong with the line that represents a stream, 
the checkbox will not be set, and ResSim will not import that 
stream element. 

9. Gap Tolerance (see Figure 5.23) is used to connect stream 
elements that have a gap between the end point and the 
junction with another stream.  By default, the Gap Tolerance 
is set to zero (0.0), so ResSim can connect streams to other 
streams.  If you click Gap Tolerance, then you need to enter a 
value larger than zero in the Gap Tolerance box, which will 
allow ResSim to connect streams that might have a larger gap 
between them. 

10. The Replace Existing Stream Alignment box, allows you to 
replace the existing stream alignment with the one being 
imported from the selected ArcView® shapefile. 

11. Once everything is set, click Import.  The stream alignment 
will be automatically drawn in the display area.  From the File 
menu, choose Close and the Import Stream Alignment dialog 
box (Figure 5.23) will close. 

5.4 Exporting a Stream Alignment 
If you have digitized a stream alignment by hand, you might want to save 
that stream alignment as an ArcView® shapefile.  To export a stream 
alignment you must have a stream alignment in the display area. 

To export a stream alignment: 

1. You must be in the Watershed Setup Module.  On the 
Module list, click Watershed Setup. 

2. From the Watershed menu, point to Export, and then select 
Stream Alignment. 
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3. A Save File browser (Figure 5.25) will open.  Enter a name in 
the File Name box.  Click OK, the Save File browser will 
close, and you will have an ArcView® shapefile of the 
displayed stream alignment. 

5.5 Configuring Stream Alignment Display Properties 
You can change the color, line width, font, and tic mark properties of a 
Stream Alignment using the Stream Alignment Properties Editor.  The 
section on “Viewing and Configuring Layer Properties” in Chapter 4, 
Section 4.4 describes in detail how to change Stream Alignment display 
properties. 

To change stream alignment properties: 

1. From the View menu, select Layers. 
2. The Layer Selector dialog box will open. 
3. Right-click on the StreamAlignment layer in the tree.  From the 

shortcut menu, click Properties. 
4. The Stream Alignment Properties dialog box (Figure 5.26) will 

open. 

Figure 5.26  Stream Alignment Properties Dialog Box 

Figure 5.25  Save File Browser 
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5. To change the color of the stream alignment layer, select a color 
from the Stream Color list.  The preview pane to the right of the 
Edit Properties box will display the selected color. 

6. Click OK and the Stream Alignment Properties dialog box will 
close and the color change will appear in the display area. 

7. Repeat steps 5 and 6 for any other changes you wish to make to 
the stream alignment properties. 

8. Once you have finished, from the Layer Selector dialog box, 
click OK to close. 

5.6 Saving the Stream Alignment 
Since creating a stream alignment can be a very detailed activity, you 
should save it frequently during its creation.  From the File menu, click 
Save Watershed.  This command will save all of the stream alignment 
properties and the appropriate files created and used by ResSim for the 
stream alignment. 

5.7 Listing of Streams 
Once you have your stream alignment completed, it’s a good idea to 
review the streams in your stream alignment.  From the Watershed Setup 
Module, there is a report that contains this information. 

1. From the Reports menu, select List of Streams and a report 
similar to Figure 5.27 will appear. 

 
Figure 5.27  List of Streams in Stream Alignment 

2. This report provides a list of streams and their descriptions that 
have been input for the stream alignment. 

3. From the File menu of the report, you can print the report, or 
you can export the report as an ASCII tab-delimited file. 

4. Click Close and the List of Streams report will close. 


